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1 WebWhacker is an off-line browsing tool that enables you to save your favorite 
Web sites, organize them into categories, and use your favorite Web browser to 
surf the Net off-line–with faster loading and no additional on-line charges. 
Developed by the Blue Squirrel , WebWhacker downloads entire Web 
pages or sites–including text (HTML), images, and other objects–and stores them 
on your local desktop machine or your file server. By reducing your dependency 
on an Internet connection, WebWhacker saves you time and money. 

How It Works For each of your favorite Web sites, you subscribe to its URL, assign it to a 
category, specify how many levels you want to download, and decide how often 
you want your subscription to be renewed. Then you whack, or download, the site 
to your local machine. Whacked sites provide a locally stored mirror image of the 
original Web site which can be viewed and navigated locally with your Web 
browser. Besides being economical, this approach gives you more control.

Back Up Your 
WebWhacker 
Database

Be sure to include the WebWhacker DataBase file in your daily backup schedule. 
All databases rely on intricate linkages among the various pieces of information. 
For this reason, databases are, by their very nature, more subject to corruption 
problems than are other file types, and it is important to back them up regularly. 
WebWhacker stores all the linkage compactly in a single DataBase file; the 
additional HTML and other information is stored in additional files, which are 
not as critical to your backup strategy.
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Who Can Use WebWhacker?

Different groups can use WebWhacker to increase their productivity, protect their 
data, and decrease their on-line costs.

Businesses Corporations can use WebWhacker to: 

• Create firewalls, helping to insulate the company network or server from 
illegal outside access.

• Train employees in Web techniques without on-line access. 
• Lower on-line costs by storing frequently accessed Web sites locally.
• Limit recreational surfing by employees.
• Keep information up-to-date by setting automatic renewals.

Educators Schools can use WebWhacker to: 

• Create focus sites on topics relevant to current curriculum.
• Save teacher time by eliminating the need to monitor student choices.
• Reduce connect charges by directing and speeding up searches to desired and 

appropriate topics.
• Limit liability by pre-censoring the available sites.

Individuals Individuals can use WebWhacker to: 

• Create off-line presentations to demonstrate products or sites without “live” 
Web access.

• Store favorite sites to create a “super bookmark” file with free access.
• Set automatic updates to ensure access to the latest version of Web sites.
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What’s New?

Integrated Site 
Categorization/Web 
Manager

WebWhacker now includes the categorization features formerly found in the Web 
manager program. The WebWhacker database keeps track of category 
information, and the tree view is now part of the main WebWhacker window. As 
before, you can use the default categories or create your own to better manage 
large numbers of whacked sites.

Subscription Assistant WebWhacker now uses the Subscription Assistant to help you quickly and easily 
set up necessary parameters for a “whack.”

Improved Content 
Handling

WebWhacker no downloads background sounds, dynamic images, and 
Shockwave objects.

Blue Squirrel InstantX     WebWhacker for Macintosh now includes Blue Squirrel InstantX, allowing you to 
send your registration information across the Internet.

Background Whacking WebWhacker now whacks web sites in the background, allowing you to continue 
to use your computer to perform other tasks.

Content Filters WebWhacker now allows you to decide exactly which content to download and 
which content not to download. For example, you can instruct WebWhacker not 
to download .WAV Windows sound files or any files over 100KB. The filter 
combinations are endless.

Removable Storage 
Support

You can now export web sites to removable storage such as Zip disks or Jaz 
cartridges.

Improved Java 
Support

WebWhacker now downloads more Java than ever!
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Using WebWhacker

Using WebWhacker, you can capture your favorite sites into a proprietary 
database either by typing in a known URL (“adding” it) or by “grabbing” the site 
currently loaded in your Web browser. Once a site has been downloaded—or 
“whacked”—you can use WebWhacker to browse it while connected or off-line.

Related Pages:
Adding a New URL, pg. 3–4
Grabbing a URL, pg. 3–8

WebWhacker 
Database

WebWhacker uses a special folder (named WebWhacker DataBase ƒ) for its 
database (named WebWhacker DataBase ) which stores indexing and linking 
information on all the URLs you’ve selected and whacked. The WebWhacker 

DataBase ƒ folder also holds copies of the HTML and image files for each URL. 
These whacked pages are exactly the same as the original pages. By setting the 
Updating URL Whack Level Properties, you control how many levels of a Web site 
WebWhacker copies.

Updating URL Whack Level Properties, pg. 3–39

Off-Line Browsing If you’re not connected, you can still look at all the sites in your database. By using 
the scheduling function, you can be assured that the sites are kept up-to-date on 
a daily, weekly, or monthly basis. Of course, you can also rewhack individual sites 
or refresh your entire database at any time. See Renewing Subscribed URLs.

Renewing Subscribed URLs, pg. 3–27

Organize Your URLs Use WebWhacker to organize your whacked URLs and other favorite sites into 
categories and subcategories for easier tracking. As your needs change, add or 
subtract categories and subcategories.

You might want the categories to be general subjects. Or perhaps you want to 
categorize your URLs by business topics; for example, clients, vendors, and 
competitors. Or, if several people use a single machine, each person might want 
to set up a personal set of subcategories.
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WebWhacker Window

The heart of WebWhacker is its main window.

Toolbar The Toolbar gives you immediate, one-click access to WebWhacker’s most 
commonly used functions.

List of URLs The main window displays whacked sites in categories such as Arts, Business, and 
Education—or any other system you want. Each category appears as a folder 
containing the assigned sites and any subcategories you create. When you add a 
URL, you can assign it to a category, and you can later change a URL’s category if 
you like.

Whack Status Bar The Whack Status Bar contains information about the status of a whack in 
progress. 

List of
Subscribed URLs

Whack
Status Bar

Toolbar
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Customer Support

The first line of support should be this manual and the online Guide help file. To 
access the Guide help file, go to the question mark in the upper right corner of 
your menu bar and select WebWhacker Guide.

Visit Our Web Site If you cannot find the information you need in either of these sources, contact us 
at our Web site. All of the support options are detailed on our Customer Support 
home page: ht t p: / / www. bluesquirrel. com/ suppor t /support. ht ml .
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2 WebWhacker integrates many aspects of your Web viewing. Since it brings 
together your desktop computer or company network with your Web browser, 
and, ultimately, the entire Internet, the setup routine involves just a bit more than 
copying the program to your hard drive.

Installation Procedure Step Procedure

1. Install the WebWhacker program. See Installing WebWhacker.

2. Set program-wide preferences for WebWhacker. See Setting Program-Wide 
Preferences for WebWhacker.

If you are upgrading from a previous release of WebWhacker and want to migrate 
your earlier groups or database to the new program version, you must perform 
additional steps. For details, see Upgrading from Previous Versions.

Related Pages:
Installing WebWhacker, pg. 2–7
Setting Program-Wide Preferences for WebWhacker, pg. 2–8
Upgrading from Previous Versions, pg. 2–5
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System Requirements

Required In order to run WebWhacker, you must have at least the following setup: 

• 68020 or higher class machine
• System 7.5 or higher with Open Transport enabled. Certain models (some 

Performas, for example) can only use Open Transport with System 7.6 or later, 
and thus must be upgraded to 7.6 or 8.0 before installing WebWhacker. 

• 8MB RAM. Additional memory makes WebWhacker run faster.
• 10 MB free hard drive space (2 MB for the program; 8 MB for whacked sites)
• Active Internet connection with Open Transport, using SLIP, PPP, or direct 

connectivity. Modem connections require a 14.4 modem or higher speed link. 
The amount of time required to transfer data to the server will vary depending 
on the speed of your connection, as well as the amount of data involved.

• Web browser such as:
• Internet Explorer™ version 2.0 or higher (production versions 

recommended)
• Netscape Navigator™ version 2.0 or higher (production versions 

recommended)
• Enhanced Mosaic™ version 2.0 or later (production versions 

recommended)
• or other SpyGlass SDI standard-compliant browser.

Viewing Requirements A Web browser is required only for viewing whacked URLs. You can whack (that 
is, download) URLs from the Internet with any Web connection.

Recommended For best results, we recommend the following setup:

• 68040 or PowerPC machine
• 16 MB RAM
• System 7.6
• Additional hard drive space

If you wish to use Internet Config with WebWhacker, you must be running 
Internet Config version 1.3 or higher.
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Upgrading from Previous Versions

WebWhacker’s installation routine takes care of most of the work of upgrading 
from previous versions. If you are only upgrading the software, no additional 
steps are needed. If you are also bringing along groups created in version 1.0, or 
whacked sites created under any earlier version, you will add a few steps to the 
normal installation process.

Warning Do not delete your folder or group files if you are upgrading from WebWhacker 
1.0, or your WebWhacker DataBase file if you are upgrading from 2.0 and you 
want to retain your previously whacked sites. To migrate Version 1.0’s groups of 
subscribed URLs into the new product, you must import the database group files 
and rewhack the sites. To migrate the database from 2.0, you must make sure the 
database file is in the same folder as the new program. Note that, under current 
versions, you may have only one database, so move your old database into the new 
folder before you whack any additional sites.

Upgrading from 1.0 Step Procedure

1. Install and configure WebWhacker. See Installing WebWhacker and 
Setting Program-Wide Preferences for WebWhacker.

2. Import your earlier groups of subscribed URLs. See Importing 
WebWhacker 1.0 Groups. 

3. Rewhack the URLs you have just imported. 

Related Pages:
Installing WebWhacker, pg. 2–7
Setting Program-Wide Preferences for WebWhacker, pg. 2–8
Importing WebWhacker 1.0 Groups, pg. 2–9
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Upgrading from 2.0 Step Procedure

1. Install the new WebWhacker version in the same directory as your old 
version, following the instructions in Installing WebWhacker. When you 
reach step 5, be sure to navigate to the folder holding your current 
WebWhacker installation.

OR

If you wish to install the new WebWhacker version in a different folder, 

follow the instructions in Installing WebWhacker. When you reach step 5, 
choose a folder other than the one holding your current WebWhacker 
installation. When you finish installing the new version, 

• locate the file named WebWhacker DataBase;
• press Command-D to make a duplicate of the file;
• drag the duplicate file to the folder holding your new WebWhacker 

installation; and
• rename the duplicate file WebWhacker DataBase.

2. Configure the program as outlined in the rest of this chapter. See Setting 
Program-Wide Preferences for WebWhacker.

Related Pages:
Installing WebWhacker, pg. 2–7
Setting Program-Wide Preferences for WebWhacker, pg. 2–8
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Installing WebWhacker

Installing WebWhacker Step Procedure

1. If you are working from an installation disk, insert disk 1 in your floppy 
drive. Double-click WebWhacker Installer to start the installation process.

If you have downloaded WebWhacker as an .HQX file, convert the file by 
dragging it onto your StuffIt Expander™ or similar utility. Double-click 
the converted .SEA file to start the WebWhacker Installer.

2. When the WebWhacker splash screen appears, click Continue to engage 
the installation process.

3. The License Agreement loads. Read the Agreement and then click 
Continue to signify your agreement to the terms.

4. A screen loads, asking you to specify what operating system you are using 
and to choose how much of the program to load. Click on each option 
and read the descriptive text that appears. Choose the correct option for 
your system, then click Install .

5. In the dialog box that appears, navigate to select the folder in which you 
want to install WebWhacker. Click Install .

6. The Setup program copies all necessary files to your hard drive and creates 
a folder containing WebWhacker and related files.

7. WebWhacker notifies you when installation is complete. Choose Quit  to 
exit the installation program. 

Next Step After installing WebWhacker, you should set up your WebWhacker program 
preferences. See Setting Program-Wide Preferences for WebWhacker.

Related Pages:
Setting Program-Wide Preferences for WebWhacker, pg. 2–8
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Setting Program-Wide Preferences for WebWhacker

Before using WebWhacker, you should set up your Web browser’s location, cache 
passthru status, and connection preferences. To set other preferences, see Setting 
Preferences.

Setting Preferences Step Procedure

1. From the WebWhacker Tools menu, choose Preferences. 

2. Select the Browser/Mail  page. Under the Web Browser option, click the 
Choose... button to navigate your hard drive and find your Web browser. 

3. If you are accessing the Internet from behind a firewall or company proxy 
server, select the Proxy Server page. Enter the name or IP address and port 
number for the Remote Proxy in the HTTP  and Port text boxes. Contact 
your network administrator for this information.

4. When you have finished setting preferences, click OK .

Related Pages:
Importing WebWhacker 1.0 Groups, pg. 2–9

Next Step To import WebWhacker 1.0 groups, see Importing WebWhacker 1.0 Groups.
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Importing WebWhacker 1.0 Groups

If you acquired a useful database in WebWhacker 1.0 that you want to use in the 
new version of the program, the Import function allows you to import these 
groups of URLs. This function does not import the content of the previously 
whacked pages. It only brings the URLs of the sites into the WebWhacker window, 
ready for whacking. In order to access graphics and data from the sites, you must 
set whack levels and rewhack each URL. 

If you are currently using WebWhacker 2.0 or later you do not need to worry 
about this procedure; 2.0 and 3.0 use the same group information.

Limitation The import function can only be used for WebWhacker 1.0 group files.

1.0 Groups vs. 
2.0 Database

While WebWhacker 1.0 saved each group in a separate file, WebWhacker 2.0 and 
later versions save all whacked sites in a single database (WebWhacker DataBase 
file). You must import each version 1.0 group file separately.

Importing a 1.0 database Step Procedure

1. Go to the File menu and choose Import .

2. Navigate the folder tree that appears to find the group file you want to 
import.

3. Click on the name of the group file you want to import.

4. Click Open to import the group file. WebWhacker reads in the URLs 
contained in that file, closes the folder tree window, and switches you to 
the main WebWhacker window. The imported URLs appear on the list, 
enabled for whacking.

5. Repeat steps 1-4 for each group file you want to import.
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6. When all the groups have been imported, click on the Whack button to 
begin whacking the URLs, downloading their HTML and associated files 
into the WebWhacker database. See Whacking Sites.

Related Pages:
Whacking Sites, pg. 3–19
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Uninstalling WebWhacker

WebWhacker is easily removed from your system.

Uninstalling Step Procedure
WebWhacker

1. Open your hard drive or the network drive on which you have installed 
WebWhacker.

2. If you really want to remove the program, drag the WebWhacker folder 
containing the executables and database files to the Trash.

3. Navigate to your System Folder, and then the Preferences folder within it. 
Locate the WebWhacker Preferences file and drag it to the Trash.
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3

WebWhacker works by creating a database of URLs which have been subscribed 
to and whacked. Subscribing to a URL puts it into your database; allows you to 
assign a category, update frequency, and other properties for that particular URL; 
and then marks it for whacking. You can subscribe to a URL by typing in the 
complete URL of the Web page, or you can grab a site as you are browsing. 
Whacking (or downloading) a URL creates a copy of that site on your local hard 
drive or network server. Once you have whacked a site, you can view it again and 
again, without an on-line connection or additional connect charges. 

Creating Subscription Step Process

1. Subscribe to the desired URL by either adding or grabbing the site. See 
Adding a New URL and Grabbing a URL.

2. Whack the site. SeeWhacking Sites.

Related Pages:
Adding a New URL, pg. 3–4
Grabbing a URL, pg. 3–8
Whacking Sites, pg. 3–19
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Adding a New URL

If you know the complete URL for a site, you use this procedure to type it into 
WebWhacker without having to access your browser. During the add process you 
can specify a category, update frequency, and other properties for the URL. If you 
want to use the browser to add the URL to WebWhacker, use the procedure 
Grabbing a URL.

Related Pages:
Grabbing a URL, pg. 3–8

Category When you add a new URL, you can assign it to a category. If you want to change 
the site’s category, use the procedure Moving a URL to a New Category.

Moving a URL to a New Category, pg. 3–17

Whack Levels The whack levels you specify determine the number of pages WebWhacker 
acquires when it whacks the site. You can choose to whack only a single page, to 
whack links from the page and from the linked pages, or to whack all the pages 
linked to the page and all its linked pages. You can also decide whether or not you 
want to whack pages from other sites linked to the selected page.

Remain on Site When WebWhacker begins whacking a Web site, it whacks all links to the level you 
specify. If the page has links to pages at another site, you might not want to whack 
those pages. You can use Remain on Site to keep WebWhacker from transversing 
links to other sites. You can only use the Remain on Site option if you are specifying 
a number of levels to whack; if you are whacking all the links from a page, Remain 
on Site is selected automatically and the option is disabled.

Update Frequencies 
and Scheduling 
Preferences

The URL Update Frequency property and the Scheduling preferences work 
together in performing whacks and renewals. The URL Update Frequency is an 
individual property set separately for each URL. The Scheduling preferences are 
global (within WebWhacker), applying to all URLs. Scheduling preferences 
override Update Frequency properties (WebWhacker only looks at Update 
Frequencies when the Scheduling Preference requests it). For instance, if your 
Scheduling preferences are set for weekly on a specific day (say, Sunday) but a 
single URL’s Update Frequency property is set to daily, that URL will only be 
updated once a week (on Sunday). See Modifying URL Frequency Properties.

Modifying URL Frequency Properties, pg. 3–35
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Procedure Step Procedure

1. From the URL menu select Add. WebWhacker starts the Subscription 
Assistant, which guides you through the subscription process.

2. Select the type of “whack” (http:// , ftp:// , or <empty> ) from the 
Prefix drop-down list box. Most “whacks” you do will be the default type, 
http:// . Click onscreen to place your cursor in the URL text box, then 
type the URL address for the site you want to add. Highlight a category for 
the URL (if necessary, click the triangle to the left of the word All to 
display the categories). 

3. Click Next to go on to the second page of the Subscription Assistant. 
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4. Select the number of levels of this URL that you want to whack.

• If you only want this page, set Levels to 1.
• If you want all the links from this URL and all the links from those 

pages as deep as possible, select All Levels. Selecting All turns on 
Remain on Site; you cannot turn off Remain on Site while All Levels is 
selected (this keeps it from trying to whack the entire Web).

• If you want something between 1 level and all levels, type the correct 
number in the Levels text box, or use the spin buttons to set the 
number.

• If you don’t want WebWhacker to whack pages from other Web sites 
that are linked to this URL, select Remain on Site. 

5. If the URL you selected requires a user name and password, type your user 
name and the password in the area labeled Security. 

6. If you want to use a filter you have already defined to limit the files 
“whacked”, select that filter from the Filter  drop-down list box. See 
Creating Filters for more information. 

Related Pages:
Creating Filters, pg. 4–6
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7. Click Next to go on to the third page of the Subscription Assistant.

8. Select the frequency you want for this site. 
• To whack this site only once and never renew it, select Just This Once.
• To update this site every day (or week or month), choose Daily (or 

Weekly, or Monthly ). If you select an update cycle, WebWhacker 
automatically updates the links according to the schedule you 
established in the Preferences. 

9. Click Whack it Later or Whack it Immediately according to when you want 
the first “whack” to occur.

10. When you select OK in the Subscription Assistant, WebWhacker adds the 
URL to your site list and marks it for whacking. If you chose Whack it 
Immediately, WebWhacker immediately conducts all scheduled whacks.

Related Pages:
Setting Scheduling Preferences, pg. 4–14

Next Step When you are ready to whack the site, go to the procedure Whacking Sites.

Whacking Sites, pg. 3–19
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Grabbing a URL

You can easily add a new URL to your WebWhacker database by grabbing it from 
your Web browser. When you use this procedure, be sure you are viewing the site 
through the browser specified in your WebWhacker Browser/Mail preferences. 
Fore more information, see Setting Browser/Mail Preferences.

Whack Levels The whack levels you specify in the URL properties determines the number of 
pages WebWhacker acquires when it whacks the site. You can choose to whack 
only this single page, whack links from the page and from the linked pages, or 
whack all the pages linked to the page and all its linked pages. You can also choose 
whether or not you want to whack pages from other sites linked to the selected 
page. For more information about setting whack levels see Updating URL Whack 
Level Properties.

Related Pages:
Setting Browser/Mail Preferences, pg. 4–11
Updating URL Whack Level Properties, pg. 3–39

Remain on Site When WebWhacker begins whacking a Web site, it whacks all links to the level you 
specify. If the page has links to pages at another site, you might not want to whack 
those pages. You can use Remain on Site to keep WebWhacker from transversing 
links to other sites. You can only use the Remain on Site option if you are specifying 
a number of levels to whack; if you are whacking all the links from a page, Remain 
on Site is selected automatically and the option is disabled.

Update Frequencies 
and Scheduling 
Preferences

The URL Update Frequency property and the Scheduling preferences work 
together in performing your whacks and renewals. The URL Update Frequency is 
an individual property set separately for each URL. The Scheduling preferences 
are global (within the context of WebWhacker), and apply to all URLs. Scheduling 
preferences can override Update Frequency properties because WebWhacker only 
looks at Update Frequencies when the Scheduling Preference requests it. For 
instance, if your Scheduling preferences are set for weekly on a specific day (say, 
Sunday) but a particular URL’s Update Frequency property is set to daily, that 
URL will only be updated once a week (on Sunday). For more information see 
Modifying URL Frequency Properties.

Modifying URL Frequency Properties, pg. 3–35
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Category When you grab a URL, the Subscription Assistant lets you assign it to a category.  
If you want to change the site’s category classification, use the procedure Moving 
a URL to a New Category.

Related Pages:

Moving a URL to a New Category, pg. 3–17

Grabbing a Site Step Procedure

1. Using your Web browser, display the URL you want to grab.

2. Switch to WebWhacker and select Grab from the Toolbar. Or go to the 
URL menu and select Grab. WebWhacker starts the Subscription 
Assistant, which guides you through the subscription process.

3. If necessary, change the type of “whack” (http:// , ftp:// , or 

<empty> ) from the Prefix drop-down list box and the URL address for 
the site you grabbed. Highlight a category for the URL (if necessary, click 
the triangle to the left of the word All to display the categories). 
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4. Click Next to go on to the second page of the Subscription Assistant. 

5. Select the number of levels of this URL that you want to whack.

• If you only want this page, set Levels to 1.
• If you want all the links from this URL and all the links from those 

pages as deep as possible, select All Levels. Selecting All turns on 
Remain on Site; you cannot turn off Remain on Site while All Levels is 
selected (this keeps it from trying to whack the entire Web).

• If you want something between 1 level and all levels, type the correct 
number in the Levels text box, or use the spin buttons to set the 
number. Although you can enter numbers up to 999 in this box, you 
will run out of hard drive space long before whacking 999 levels.

• If you don’t want WebWhacker to whack pages from other Web sites 
that are linked to this URL, select Remain on Site. 

6. If the URL you selected requires a user name and password, type your user 
name and the password in the area labeled Security. 
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7. If you want to use a filter you have already defined to limit the files 
“whacked”, select that filter from the Filter  drop-down list box. See 
Creating Filters for more information. 

8. Click Next to go on to the third page of the Subscription Assistant.

Related Pages:
Creating Filters, pg. 4–6

9. Select the frequency you want for this site. 
• To whack this site only once and never renew it, select Just This Once.
• To update this site every day (or week or month), choose Daily (or 

Weekly, or Monthly ). If you select an update cycle, WebWhacker 
automatically updates the links according to the schedule you 
established in the Preferences. 

10. Click Whack it Later or Whack it Immediately according to when you want 
the first “whack” to occur.

11. When you select OK in the Subscription Assistant, WebWhacker adds the 
URL to your site list and marks it for whacking. If you chose Whack it 
Immediately, WebWhacker immediately conducts all scheduled whacks.

Setting Scheduling Preferences, pg. 4–14
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Next Step When you are ready to whack the site, go to the procedure Whacking Sites.

Related Pages:
Whacking Sites, pg. 3–19
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Working with Categories

WebWhacker displays Web sites according to categories such as Arts, Business, 
and Education, or any other categorizing system you want to use. Each category 
appears in the main window as a folder containing the assigned sites and any 
subcategories you have created. 

You can use organize your URLs into categories and subcategories to make it 
easier to keep track of them. You might want the categories to be topics or areas 
of interest. Or perhaps you want to categorize your URLs by business topics; for 
example, clients, vendors, and competitors. Or, if several people use a single 
machine, each person might want to set up a personal set of subcategories.

Adding and Deleting 
Categories

You can set up categories and assign URLs to one or more categories. Use the 
procedure Adding Categories to add new categories and subcategories, and the 
procedure Deleting Sites and Categories to delete categories you no longer need. 

After you have established the categories you want, you can use the procedure 
Moving a URL to a New Category to move a URL between categories.

Related Pages:
Adding Categories, pg. 3–15
Deleting Sites and Categories, pg. 3–16
Moving a URL to a New Category, pg. 3–17

Displaying Categories 
and Contents

The main window displays your subscribed URLs according to category.

Click the triangle next to a category folder 

• to display its subcategory folders, if any,
• or to display its contents.
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Adjust Column Width You can adjust the width of the URL and Title columns by dragging the bar that 
separates the names of each column. 

You can use the categorized URLs to surf the Net, looking for information in a 
particular area. Basically, you just open your Web browser and WebWhacker, then 
double-click the sites you wish to view.

Browsing Step Procedure

1. Start WebWhacker.

2. In the main window, open the desired category folder.

3. Locate the URL you want to browse.

4. Double-click the name of the URL. WebWhacker starts your browser 
automatically and the page appears in your Web browser’s window. 

The complete URL 
address of the site 
as it appears on the 
Internet

The name from 
the title bar of the 
Web page.
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Adding Categories

You can sort your database of subscribed URLs into as many (or as few) categories 
as you want. You may even create subcategories within a category. Each category 
or subcategory is displayed as a folder in the main window.

Adding Categories Step Procedure

1. From within the main window, click on the word All  labeling the folder at 
the top of the list. 

2. If you want to add a subcategory to an existing category, click on the name 
of the folder that should contain the subcategory. 

3. From the Category menu, select Add Category to display the New Category 
dialog.

4. Type the name of the new category in the Category Name text box. 

5. When you’re finished, click OK .
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Deleting Sites and Categories

If you no longer need a URL or a category, you can delete it from the list. Deleting 
a category removes all the URLs assigned to that category also. If a URL is assigned 
to more than one category, it is only removed in the deleted category. It is not 
deleted from other categories. 

Deleting
sites and categories Step Procedure

1. Click on the URL or category you want to delete. 

2. Go to the Edit menu and select Cut or Clear.

Or press delete or del on your keyboard. 

3. WebWhacker removes the URL or category from your list.
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Moving a URL to a New Category

From time to time, your category needs may change. If one category becomes too 
large, you may want to create subcategories or even new main categories. You can 
easily move URLs to new categories without any need to go on-line or to re-type 
the information. 

Moving URLs to
New Categories Step Procedure

1. From within the main window, open the folder for the category which 
currently contains the URL you want to move.

2. Click on the URL you want to move. This selects the URL, which should 
now be highlighted.

3. Keeping the mouse button pressed, drag the URL to its new category 
folder. When the folder name is highlighted, release the mouse button. 

OR

With the URL highlighted, go to the Edit menu and choose Cut. Then click 
on the folder to which you want to move the URL, go to the Edit menu, and 
choose Paste. If you use this method you will have to re-whack the pages 
(WebWhacker will inform you of this fact).

4. Your URL is now located in its new category folder. If you wish, open the 
new category folder to verify that your URL is present.
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Changing a Site’s Whack Status

Before you can begin whacking, you have to tell WebWhacker which URLs you 
want to whack. Enabled URLs have a whacking knife over their icon (  or ). 
A small globe icon ( ) indicates that the URL site is still only on the Internet and 
has not yet been whacked, that is saved to your hard drive or local network server.

Enabling/Disabling URLsStep Procedure

1. Click on the icon of each URL whose whack status you want to change.

Or select the URL, go to the URL menu, and select either Enable Whack or 
Disable Whack. WebWhacker changes the icon to indicate the site’s new 
status.

2. When you are ready to begin whacking, the enabled URLs are whacked 
based on the levels specified in their properties, while all unmarked URLs 
are excluded from the procedure.You can perform the whack at once, or 
you can set WebWhacker to whack all enabled URLs at a later time (for 
example, after hours when connection rates are lower.). Use the procedure 
Setting Scheduling Preferences to set WebWhacker to update your URLs 
according to a schedule.

Related Pages:
Updating URL Properties, pg. 3–30
Setting Scheduling Preferences, pg. 4–14

Next Step When you are ready to whack the site, go to the procedure Whacking Sites.

Whacking Sites, pg. 3–19
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Whacking Sites

When you request a whack, WebWhacker looks at every URL that you have 
enabled for whack. If the URL has been whacked before, WebWhacker queries its 
server to determine whether the requested page has changed since the previous 
whack date. If the server indicates that the page has been changed, if you’ve added 
levels to the whack or if it’s a new page, WebWhacker downloads the page.

If you set preferences to whack according to a schedule, the URLs must be marked 
for whack and the Whack option must be checked in scheduling preferences. 

Whacking a Web Site To perform a whack either:

• Click the Whack button on the Toolbar OR select Whack from the File menu.

WebWhacker copies the current page and the specified number of link levels to 
your hard drive or local network. When the site has been whacked the icon next 
to the URL changes to a globe on a sheet of paper ( ).You can now view it locally, 
without an Internet connection.

Stopping a Whack If, for some reason, you want to stop a whack, click the Stop button on the Toolbar. 
The Stop button may not engage immediately. In particular, a Whack will not be 
stopped during the connection, extraction, or linking phases (which you can 
identify by watching the Whack status pane for the message “Connecting…”, 
“Extracting...”, or “Linking files...”).

Why a Whacked URL 
May Not Update

• The web page’s server indicates to WebWhacker that the page hasn’t changed 
since the last time it was downloaded by WebWhacker.

• You expected to whack according to the schedule, but the scheduling 
preferences weren’t set to include whacks. Use the procedure Setting 
Scheduling Preferences to update the preferences.

• It wasn’t marked to whack. Use the procedure Changing a Site’s Whack Status 
to enable the URL for whacking.

Related Pages:
Setting Scheduling Preferences, pg. 4–14
Changing a Site’s Whack Status, pg. 3–18
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Browsing Sites

You can quickly display a URL from the WebWhacker window. If you have 
whacked the URL ( ) it is loaded directly from the WebWhacker database. If it is 
a new URL that has not yet been whacked ( ), WebWhacker uses your browser 
to access the URL site.

Related Pages:
Renewing Subscribed URLs, pg. 3–27
Setting Browser/Mail Preferences, pg. 4–11

Latest Version of URLs The page that appears in your browser is the “whacked” version of the URL that 
resides on your local hard drive or network. If the URL is one that changes 
frequently, or if you just want to make sure you are viewing the latest version, 
connect to the net and click once on the Renew button on the Toolbar to update 
your version. See Renewing Subscribed URLs.

Browsing Sites Step Procedure

1. From the WebWhacker window, select the URL you want to browse. 
Then from the URL menu, select Browse.

OR 

Go to the WebWhacker window and double-click the name of the URL.

2. WebWhacker starts your Web browser (if it is not already running) and 
displays the page in your browser’s window. 

Access Problems If your Web browser seems suddenly unable to access its network connection, you 
may have set your Browser preferences incorrectly. For more information, see 
Setting Browser/Mail Preferences.
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Displaying a List of URLs

WebWhacker List When you open WebWhacker, a list of all subscribed sites is shown in the upper 
portion of the window, in a hierarchical list of the URLs and their associated files. 
If a URL has been whacked, click on the small triangle next to the URL to display 
the associated files.

Headline Page You can also use the WebWhacker Headlines function to create a Web page with 
links to all the top-level, whacked URLs in the WebWhacker database.

Viewing Headlines Select Headlines from the Toolbar or go to the File menu and select View 
Headlines. WebWhacker creates a Web page listing your top-level whacked URLs 
as links.
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Click on link
to view page
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Can’t Load the 
Headlines Page

Your Headlines page reflects the list of top-level URLs you have whacked to your 
hard drive or local network server. If you cannot load it from your Web browser, 
there are several possible causes:

Cause

Solution

WebWhacker is not running.

Double-click on your desktop WebWhacker icon. 

Cause

Solution

Your Web browser is not running.

Turn on your browser.

Cause

Solution

Your Internet connection is faulty.

Contact your network administrator or Internet service 
provider.
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Searching the Database

WebWhacker allows you to search for specific words or phrases contained in the 
title and/or body text of any of your whacked URLs. 

Boolean Logic The searching facility supports Boolean search expressions (AND, OR, NOT). 
These search expressions are case-sensitive and must be typed in all capital letters. 

• To expand your search, use OR (or “|”) between the search terms. The search 
finds all sites containing any one of the search terms.

• To narrow your search, use AND (or “&”) between the search terms. The 
search finds only those sites containing all of your search terms.

• To eliminate all sites containing certain terms, use NOT (or “!”) before the 
search term. The search finds only those sites that do not contain the negated 
search term. You may occasionally encounter a problem in parsing queries 
using the NOT function. You can often sidestep these problems by using 
parentheses to group search terms. For example, if “x NOT y” does not work 
as expected, try “x AND (NOT y)”.

• To combine multiple levels of search terms, use parentheses to group each 
level together. If you do not use parentheses, the program attempts to 
understand your request by assigning requests an order of precedence (from 
highest to lowest: NOT, AND, OR). If you are not well-versed in Boolean logic, 
this may lead to unexpected outcome. Using parentheses to be as specific as 
possible will help ensure that your request is interpreted as you want.

Searching for 
Punctuation

To search for punctuation marks, you must enclose them in quotation marks (that 
is, to search for a question mark, type “?”). You cannot search for quotation marks 
(that is, """ doesn’t work).

Searching by Case Search text is not case-sensitive. For example, WOMAN will find WOMAN, 
woman, Woman, even woMan. 
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Procedure Step Procedure

1. In WebWhacker, click the Search button on the Toolbar.

Or go to WebWhacker’s Tools menu and choose Search.

WebWhacker displays the Search dialog.

2. In the Look for  box, type the word or words you want to find. 

3. If you want to search URL Titles only, select Title  in the Look in  box. If you 
want to search the entire text of the URLs, select Title and Body. Title  
searches are quicker; Title and Body searches are more complete.

4. Click on Find to initiate the search. The list of URLs meeting your criteria 
appears in the Results text box. 

5. When you see the URL title you want, double-click on it to load the page 
into your Web browser.
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Viewing Modified URLs

The View Modified tool displays a list of URLs that have been whacked, 
rewhacked, or renewed recently; that is, that have been downloaded from the Web 
to your hard drive or local network. You can specify the number of days included 
in the query.

Viewing Modified Sites Step Procedure

1. From the Tools menu, select View Modified . WebWhacker displays the 
View Modified dialog.

2. In Modified in __ days, type the number of days (previous to today) during 
which the URLs may have been downloaded (whacked or renewed).

3. Click Query to begin the search of the whacked URLs. WebWhacker 
displays a list of the URLs and Titles of all sites that have been modified 
within the specified number of days.

4. When you are finished examining the list, click Done to close the dialog 
box.
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Renewing Subscribed URLs

To keep your information up to date, you may want to renew your URLs by setting 
their update frequency. You can set WebWhacker to update URLs automatically 
daily, weekly, or monthly; or you can manually update whacked URLs. See 
Scheduling a Whack or Renewal for more information about automatic renewals.

Related Pages:
Scheduling a Whack or Renewal, pg. 4–4

How It Works When you request a renewal, WebWhacker looks at every whacked URL in its 
database and compares its modified date to the current date. If, based on its 
update frequency property setting, the URL is scheduled for a renewal, 
WebWhacker then queries the site server to determine whether the page has 
changed. If the server indicates that the page has been changed, WebWhacker 
downloads the changed page. Only whacked pages are renewed, if a page has not 
been whacked it won’t be renewed.

On the other hand, when you request a whack, WebWhacker looks at every URL 
that you have enabled for whack and queries their servers to determine whether 
the pages have changed. If a server indicates that a page has been changed, 
WebWhacker downloads the changed page (that is, rewhacks or updates the 
page). If a particular page has never been whacked, it will, of course, be 
downloaded (whacked).

Problems If there is a problem with the renewal, you may be able to use the Error List to 
determine what went wrong.

Viewing the Error List, pg. 3–29
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Renewing 
Subscribed URLs Step Procedure

1. Open the main WebWhacker window.

2. Be sure you have set the Update Frequency properly for all whacked URLs.

3. Click the Renew button on the Toolbar.

Or go to the File menu and select Renew.

4. Watch the window at the bottom of the WebWhacker window to 
determine the current status of your renewals. When the message says 
Whack complete, your renewal is completed.

Related Pages:
Modifying URL Frequency Properties, pg. 3–35

Stopping a Renewal If you want to stop a renewal before it has been completed, click the Toolbar’s Stop 
button (which has replaced the Renew button).

It may take WebWhacker a moment to respond to your request before it stops 
whacking. In particular,WebWhacker does not pause during the connection 
process and extraction process (when it downloads a site and then unpacks the list 
of required files). You can tell if you are in the connection or extraction process by 
watching the messages in the status window.

Why a Renewed URL 
May Not Be 
Re-Downloaded

• It hasn’t changed since the last time it was downloaded by WebWhacker.
• It was already updated within its update frequency period. For example, the 

URL is set to renew weekly, and it was renewed sometime in the past week.
• Its renewal frequency is Never.
• You asked WebWhacker to renew the URLs but the Renewal option in 

Preferences is unchecked. This prevents the URLs from being updated using 
the Renewal function.

• You asked WebWhacker to renew a URL that has never been whacked. A URL 
cannot be renewed if it has not been whacked in the first place. However if 
WebWhacker encounters new pages at the site which meet the whacking level 
you specified, the program downloads these new pages during the renewal 
process.
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Viewing the Error List

You can display a list of all the errors WebWhacker encountered in whacking or 
renewing subscribed URLs. When you select a URL from the error list, 
WebWhacker displays the errors associated with that URL.

Error Indicators A red icon next to a URL indicates an error occurred while whacking that URL. 
The problem could be as simple as the user cancelling a whack, or it may indicate 
that a URL or subordinate file could not be found. In general, a red globe ( ) 
indicates a problem with downloading the URL; if the red image is a smaller globe 
on a piece of paper ( ), that indicates a problem with one of the subordinate files 
(usually an image that could not be found).

Persistence of Errors in 
Memory

Check error conditions immediately. Error conditions are not retained once you 
exit the program. So the error list shows only errors from the current session.

Displaying Errors Step Procedure

1. Go to the Tools menu and select View Errors  to display a list of all URLs 
with problems.

2. Select the URL whose errors you want to review. WebWhacker displays 
the errors associated with that URL in the lower window labelled Errors .
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Updating URL Properties

Every URL has a series of properties associated with it. You can update some of the 
properties displayed; others are only for your information. 

Viewing and Updating
URL Properties Step Procedure

1. Select the URL whose properties you want to view or change.

Click the Props button on the Toolbar, or go to the URL menu and select 
Properties. WebWhacker displays the URL Properties dialog box with the 
Attributes  page on top.

WebWhacker_Mac.BK : 3_Using  Page 30  Friday, September 12, 1997  1:50 PM



Using WebWhacker

WebWhacker User’s Guide 3–31

2. Select the page for the properties you want to view or change:

• Attributes .The basic information about the site, including its title, 
URL address, and current status. Since WebWhacker loads all of this 
information for you, you can not change it. See Viewing Attribute 
Properties.

• Security. Security settings include the user name and password 
associated with the site. You can update both the user name and 
password. See Updating Security Properties.

• Update Frequency. This setting determines how often this URL is 
scheduled for update. This property works in conjunction with your 
scheduling preference. See Modifying URL Frequency Properties.

• Errors. This page displays any errors encountered while whacking or 
renewing the URL. See Viewing Error Properties.

• Whack Levels. This property allows you to change the number of 
levels of links that you want to download from the particular URL. 
See Updating URL Whack Level Properties.

Related Pages:
Viewing Attribute Properties, pg. 3–32
Updating Security Properties, pg. 3–33
Modifying URL Frequency Properties, pg. 3–35
Viewing Error Properties, pg. 3–37
Updating URL Whack Level Properties, pg. 3–39

WebWhacker_Mac.BK : 3_Using  Page 31  Friday, September 12, 1997  1:50 PM



Using WebWhacker

3–32 WebWhacker User’s Guide

Viewing Attribute Properties

The Attribute Properties include basic information about a subscribed URL 
including its title, URL address, and current whacked status. 

Viewing Attributes Step Procedure

1. Select the URL whose properties you want to view.

Click the Props button on the Toolbar, or go to the URL menu and select 
Properties. WebWhacker displays the URL Properties dialog.

2. If necessary, click on Attributes . WebWhacker displays the attributes 
associated with the URL. This information cannot be changed.

3. If you want to look at or update another property, select the appropriate 
page.

If you are finished updating properties, select OK . 
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Updating Security Properties

The Security Properties allow you to update the user name and password 
associated with a particular URL. The password is not displayed. 

Viewing and Updating 
Security Properties Step Procedure

1. Select the URL whose properties you want to view or modify.

Click the Props button on the Toolbar, or go to the URL menu and select 
Properties. WebWhacker displays the URL Properties dialog.

2. Select the Whack page. WebWhacker displays the user name and clear text 
(bullets) for the password assigned to this URL, along with other 
whack-related properties.

3. If you want to change the user name or password for this particular URL, 
enter the new information.
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4. To look at or update another property, select the appropriate page. 

If you are finished updating properties, select OK . 
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Modifying URL Frequency Properties

Use the Update Frequency Properties to establish how frequently a subscribed 
URL will be scheduled for update. This dialog works in conjunction with your 
scheduling preference.

Viewing and Modifying
Frequency Properties Step Procedure

1. Select the URL whose properties you want to view or modify.

Click on the Props button on the Toolbar, or go to the URL menu and select 
Properties. WebWhacker displays the URL Properties dialog.

2. Select the Whack page. WebWhacker displays the frequency you 
established for this site, along with other whack-related properties.

3. If you want to change how often the URL is updated, select the new 
frequency from the drop-down list box.
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4. To look at or modify another property, select the appropriate page.

If you are finished modifying the URL’s properties, select OK . 
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Viewing Error Properties

You can use the Error Properties to review any errors encountered while whacking 
or renewing a URL. You can’t make any changes to this list but you can use it to 
analyze error conditions.

Persistence of Errors Check error conditions as soon as possible. WebWhacker does not retain errors in 
memory when you exit the program. So the Error Properties show only errors 
from the current session.

Procedure Step Procedure

1. Select the URL whose properties you want to check.

Click the Props button on the Toolbar, or go to the URL menu and select 
Properties. WebWhacker displays the URL Properties dialog.

2. Select the Errors  page. WebWhacker displays the Error List with all the 
error conditions associated with this URL.
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3. To look at or update another property, select the appropriate page.

If you are finished updating properties, select OK . 
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Updating URL Whack Level Properties

You can set the number of levels you want to download from a subscribed Web 
site. Normally, whack levels are set when a site is grabbed or added. In addition, 
you can change the whack levels later using this procedure.

Related Pages:
Grabbing a URL, pg. 3–8
Adding a New URL, pg. 3–4

Whack Levels The whack levels you specify in the URL properties determines the number of 
pages WebWhacker acquires when it whacks the site. 

You can choose to only whack this single page, whack links from the page and 
from the linked pages, or whack all the pages linked to the page and all its linked 
pages. You can also indicate whether or not you want to whack pages from other 
sites linked to the selected page.

• If you only want this page, set Levels to 1.
• If you want all the links from this URL and all the links from those pages as 

deep as possible, select All Levels.
• If you want something between 1 level and all levels, type the correct number 

in the Levels text box, or use the spin buttons to set the number.
• If you don’t want WebWhacker to whack pages from other Web sites that are 

linked to this URL, select Remain on Site. If you chose to whack All levels, 
Remain on Site is selected automatically and the option is disabled. 

• We do not recommend choosing All Levels on large sites (or most commercial 
sites). If you want the current page to maintain some links but need to limit 
the size of the whack, choose 1 or 2 levels.

Remain on Site If you don’t want to whack pages that are on a site different from the original site, 
select Remain on Site. If you choose to whack All Levels, Remain on Site is selected 
automatically and the option is disabled.
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Viewing and Updating
Whack Level Properties Step Procedure

1. Select the URL whose whack levels you want to update.

Click on the Props button on the Toolbar. Or go to the URL menu and 
select Properties or Whack Levels. 

2. If you are using the Props button or the URL menu’s Properties command 
to change whack levels, WebWhacker displays the URL Properties dialog. 
Select Whack. WebWhacker displays the levels assigned to this site, along 
with other whack-related properties.

If you are using the URL menu’s Whack Levels command, WebWhacker 
displays the Whack Levels dialog. 

3. Set your whack levels. For details, see the section on setting Whack Levels, 
under Adding a New URL.

Related Pages:
Select your whack levels, pg. 3–6
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4. If you don’t want to whack pages from other sites linked to this site, select 
Remain on Site. If you chose to whack All levels in the previous step, 
Remain on Site is automatically selected and the option is disabled.

5. If you are using the Properties and want to look at or update another 
property, select the appropriate page. 

If you are finished updating properties, select OK .

WebWhacker_Mac.BK : 3_Using  Page 41  Friday, September 12, 1997  1:50 PM



Using WebWhacker

3–42 WebWhacker User’s Guide

Deleting URLs

You can use this procedure to remove URLs from your WebWhacker database.

Database Compression WebWhacker does not currently compress its database when you delete sites; 
however, the program reuses space recovered from the deleted information before 
using additional hard disk space. A future release will support database 
compression.

Procedure Step Procedure

1. To delete one or more URLs, select the URL or URLs you want to delete.

To select multiple non-contiguous sites, hold down the Command key to 
select (or deselect) several URLs. 

Or hold down the Shift key to select all the URLs between the two points.

2. When you have selected the URLs you want to delete, go to the Edit menu 
and select Clear or Cut. WebWhacker removes all the selected URLs from 
the database and from your list. 
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4 WebWhacker includes several advanced features that make it easier for you to 
access and update your Web sites.

Scheduling WebWhacker provides a sophisticated scheduling function that you can use to 
schedule renewals and rewhacks. In combination with the Update Frequency 
property assigned to each URL, the scheduling function lets you determine how 
often and exactly when you want WebWhacker to update your database of 
subscribed URLs.

See Modifying URL Frequency Properties for more information about establishing 
an individual URL’s update frequency and Scheduling a Whack or Renewal for 
information on setting a global schedule for your database.

Related Pages:
Modifying URL Frequency Properties, pg. 3–35
Scheduling a Whack or Renewal, pg. 4–4
Setting Preferences, pg. 4–8
Exporting Files, pg. 4–17
Using FTP with WebWhacker, pg. 4–19

Preferences This section contains detailed instructions for setting each of the WebWhacker 
system-wide preferences. See Setting Preferences for more information.

Export Function You can use the WebWhacker export function to save HTML, GIF, and other types 
of files from subscribed URLs in your WebWhacker database to independent files 
on your hard drive. Using word processing and photo-editing software, you can 
then review and update pages and graphics you’ve found on the Net. See Exporting 
Files and Using FTP with WebWhacker.
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Scheduling a Whack or Renewal

Scheduling a whack or renewal to take place requires you to coordinate a number 
of different settings. In addition to subscribing to the URL (by adding or grabbing 
it) and enabling it (if you want to perform an unattended whack), you must set up 
the correct URL Update Frequency and Scheduling preferences. Finally, if you 
want the whacks and renewals performed in your absence, you must remember to 
leave your computer on with WebWhacker running.

Limitations You must use a Web connection that does not require you to type your name and 
password. If your Internet Service Provider (ISP) requires you to enter your name 
and password manually each time (rather than with a script or a remembered 
password), you can not perform scheduled, unattended whacks or renewals.

Coordinating 
Update Frequencies 
and Scheduling 
Preferences

The Update Frequency property and the Scheduling preferences work together in 
performing your whacks and renewals. Remember that the URL Update 
Frequency is an individual property which must be set separately for each URL. 
The Scheduling preferences are global (within the context of WebWhacker) and 
apply to all URLs. 

Scheduling preferences override Update Frequency properties because 
WebWhacker only looks at Update Frequencies when the Scheduling Preference 
requests it. For instance, if your Scheduling preferences are set for weekly on a 
specific day (say, Sunday) but a particular URL’s Update Frequency property is set 
to daily, that URL will only be updated once a week (on Sunday).

Related Pages:
Modifying URL Frequency Properties, pg. 3–35

Coordinating Whacks 
and Renewals

If you set your scheduled whacks and renewals to occur during the night, be sure 
you do not also leave your machine running on a large whack. Ongoing whacks 
take precedence over scheduled whacks and renewals. If a whack is already in 
progress, a scheduled whack or renewal will not kick off. The scheduled whacks 
and renewals are not reset; the scheduling cycle is simply skipped for that time.
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Scheduling Whacks
and Renewals: 
Overview of Procedure Step Procedure

1. Subscribe to the desired URLs by adding or grabbing them. See Adding a 
New URL and Grabbing a URL.

2. For new whacks, be sure the subscribed URLs have been enabled. See 
Changing a Site’s Whack Status.

3. For renewals, be sure the subscribed URLs have the appropriate update 
frequency set. See Modifying URL Frequency Properties.

Be sure that you have set scheduling preferences correctly. See Setting 
Scheduling Preferences. 

4. If you want to perform the whack immediately, click the Whack button 
from your Toolbar, or choose Whack from the File menu. 

If you want to perform the renewals immediately after the whacks, click the 
Renew button from your Toolbar, or choose Renew from the File menu.

5. If you want WebWhacker to perform the whack or renewal in your 
absence, you must also have your Web connection set up so that it 
automatically sends your username and password to your Internet Service 
Provider. If you normally type in your username and password manually, 
the scheduled whack or renewal will not occur.

6. When you leave, be sure your computer is running, is plugged into a 
modem or network card, has an active Internet connection, and has 
WebWhacker running.

Related Pages:
Adding a New URL, pg. 3–4
Grabbing a URL, pg. 3–8
Changing a Site’s Whack Status, pg. 3–18
Modifying URL Frequency Properties, pg. 3–35
Setting Scheduling Preferences, pg. 4–14
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Creating Filters

In some cases you may only want certain types of information from a site. For 
example, modem users may not want to download large files like movies or online 
manuals. The Subscription Assistant has a drop-down list box labeled “Filter” that 
lists all filters you define. This lets you apply the filter to Subscriptions you create.

The Filter options let you specify which types of pages are “whacked” from a 
certain site. To create a filter, do the following:

Defining a Filter Step Procedure

1. Click the Filters button in the WebWhacker toolbar to bring up the Filter 
Templates dialog.

2. Click the New button to bring up the New Filter dialog.

3. Type a name for this filter into the Filter Name text box. Use a name that 
will be meaningful; probably it should refer to the site name and 
something about the filter's restrictions (for example, “White House--text 
only”).

4. If you want to keep files with certain extensions from being downloaded, 
click File Extension and then type the extensions for those file types into 
the text box at the right. For example, you could save downloading time 
by excluding most pictures by typing jpg,gif in the text box.

When you are finished, or if you don't want to restrict by file extensions, go 
on to the next step.

5. If you want to avoid pages or linked files (graphics, movies, etc.) above a 
certain size, click File Size, then click Restrict To: and type in a number of 
kilobytes to be the maximum size.

When you are finished, or if you don't want to restrict by file size, go on to 
the next step.
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6. If you want to keep the “whack” from going beyond the current server's 
directory structure, click Directory, then click Remain in Directory. The 
“whack” will go into all subdirectories below the specified one, but not to 
any levels “above” that specified (as opposed to Remain on Site, which 
allows such other directories.)

When you are finished, or if you don't want to restrict by directory, go on 
to the next step.

7. If you want to keep the “whack” from going beyond the specified site, 
click Site, then click Remain on Site.

When you are finished, or if you don't want to restrict by site, go on to the 
next step.

8. If you want to keep certain file types from being downloaded, click MIME 
Filter and then click the appropriate check boxes at the right. For example, 
if you don't have or plan to get software to decompress GZIP files, you 
could click application/x-gzip to avoid downloading them.

Note that you might want to prevent “All Movie Types” or “All Sound 
Bites” if you don't need that type of information and want significant 

savings in your download times.

9. When you have finished defining the filter, click OK to save it in the filters 
list.
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Setting Preferences

The Preference functions allow you to set various system-wide preferences.

Setting Up Preferences Step Procedure

1. From the Tools menu, select Preferences. 

2. Select the tab for the preference you want to change. From the Preferences 
dialog, you can specify:

• General Preferences. Specifies whether to download in-line graphics on 
whacked pages, to show the Welcome dialog when WebWhacker starts, 
and to use Internet Config. See Setting General Preferences, pg. 4–9.

• Browser/Mail Preferences. Identifies your Web browser and specifies 

your e-mail account. See Setting Browser/Mail Preferences, pg. 4–11.

• Network Preferences. Sets up network management options. See Setting 
Network Preferences, pg. 4–12.

• Proxy Server Preferences. Sets proxy options and preferences for sites 
with firewalls. See Setting Proxy Server Preferences, pg. 4–13.

• Scheduling Preferences. Schedules site updates, in conjunction with the 

URL update frequencies. See Setting Scheduling Preferences, pg. 4–14.

Related Pages:
Setting General Preferences, pg. 4–9
Setting Browser/Mail Preferences, pg. 4–11
Setting Network Preferences, pg. 4–12
Setting Proxy Server Preferences, pg. 4–13
Setting Scheduling Preferences, pg. 4–14
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Setting General Preferences

Use the General tab of the Preferences dialog box to set basic preferences for the 
WebWhacker program.

WebWhacker Mac and 
Internet Config

WebWhacker for Macintosh is an Internet Config-aware application. This means 
that you can tell WebWhacker to get information such as your e-mail address, 
URL, and favorite browser from Internet Config, rather than setting these 
preferences up within WebWhacker. (Internet Config is a downloadable 
Macintosh utility applet that allows you to set up Internet options once and send 
your preferences to all Internet Config-aware applications.)

Configuring
General Preferences Step Preferences

1. From the Tools menu, select Preferences. Then select the General tab. 
WebWhacker displays the General preferences dialog.

2. If you want WebWhacker to ignore inline images when it whacks pages, 
select Ignore Inline Images. Ignoring inline images is the same as setting 
your browser to not display images. This makes the whacking and 
displaying of pages faster. 
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3. If you use the Internet Config utility to set up your networking options 
and want WebWhacker to gets its configuration information from 
Internet Config, put an X in the box labeled Use Internet Config. If you do 
not use Internet Config (or do not know what it is), leave this box blank.

4. If you want the Welcome dialog to load automatically when you open 
WebWhacker, select Show Welcome Dialog. You can set WebWhacker to 
bypass the Welcome dialog by clearing this check box. 

5. If you want to update another preference, select the appropriate tab.

If you are finished updating preferences, select OK .
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Setting Browser/Mail Preferences

Use the Browser/Mail preferences to specify your browser and e-mail address. 

Crossed Preferences If you have more than one browser on your system, you can only view your 
WebWhacker database from the browser set in the browser preferences. 

Setting Browser and
Mail Preferences Step Procedure

1. From the Tools menu, select Preferences. Then select the Browser/Mail 
tab. WebWhacker displays the Browser/Mail  Preferences dialog box.

2. The Web Browser option identifies the Web browser WebWhacker should 
use for browsing and grabbing sites. Click the Choose... button to navigate 
your hard drive and find your Web brows

3. Type your complete e-mail address in the Email Address text box. 

4. If you want to update another preference, select the appropriate tab.

If you are finished updating preferences, select OK . 
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Setting Network Preferences

Use the Network preferences to specify basic network management options.

Procedure Step Procedure

1. From the Tools menu, select Preferences. Then select the Network tab.

2. Enter the number of times you want WebWhacker to try to access a site if 
it is unsuccessful on the first attempt.

3. Enter the amount of time, in seconds, you want WebWhacker to wait 
before whacking or downloading subsequent URLs from the same server. 
Waiting a few seconds is proper Netiquette, so you don’t tie up a server.

4. If you want to update another preference, select the appropriate tab.

If you are finished updating preferences, select OK . 
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Setting Proxy Server Preferences

Setting Up Behind a 
Firewall

If your site is running behind a firewall, use the Proxy server preferences tab to tell 
WebWhacker the name or IP address and port number of your HTTP proxy (FTP 
proxy is not currently supported). If you are not sure of this information, contact 
your network administrator.

If you are not running behind a firewall, you need not enter this information.

Procedure Step Procedure

1. From the Tools menu, select Preferences. Then select the Proxy Server tab.

2. If you are accessing the Internet from behind a firewall or company proxy 
server, enter the name or IP address and port number for the HTTP 
proxy. Contact your network administrator for this information.

3. The FTP Proxy function is not currently implemented.

4. If you want to update another preference, select the appropriate tab. If you 
are finished updating preferences, select OK . 
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Setting Scheduling Preferences

You can use the Scheduling function to specify the schedule for URL updates. 
Scheduling works in conjunction with the URL Update Frequency property, 
which is set each time you add or grab a new URL or when you specifically change 
an existing URL’s properties. This update frequency setting is stored separately for 
each URL. The Scheduling setting, on the other hand, is set globally and 
determines how often WebWhacker attempts to check subscribed URLs to see if 
they should be updated.

Related Pages:
Modifying URL Frequency Properties, pg. 3–35

How It Works Every time you subscribe to a new URL by adding or grabbing it, WebWhacker lets 
you establish the frequency with which your subscription to that URL is renewed. 
Some URL subscriptions you may never want to renew; others you may want to 
update daily, weekly, or monthly. Based on the frequency schedule you establish 
in the program’s Scheduling preferences, WebWhacker looks at the Update 
Frequency for each URL to determine which URLs are eligible for update and then 
queries the server at that page’s original site to determine whether the site has 
changed since the last time you downloaded it. If the page has changed, 
WebWhacker renews it by reacquiring the page information. 

For example, if your preferences are set to renew daily at midnight, every night 
WebWhacker looks at all the URLs that have been assigned an update frequency. 
If the update criteria is met (the frequency is daily or today is a week or a month 
after the last update), WebWhacker queries the server at the page’s original 
Internet location to determine the page’s modification date on the server. The 
program then compares the two modification dates (on the server and on your 
local desktop). If the server-based modification date is later than your local 
modification date, the page has probably changed since your last update, so 
WebWhacker downloads the updated page.

Adding a New URL, pg. 3–4
Grabbing a URL, pg. 3–8
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Configuring Scheduling Step Procedure

1. Click the Schedule button on the Toolbar.

OR 

From the Tools menu, select Preferences. Then select the Scheduling tab. 

WebWhacker displays the Scheduling preferences page.

2. Select the scheduling options you want:

• If you want to schedule updates to occur every day, select Daily.

• If you only want to updates on weekdays (Monday through Friday, but 
not Saturday and Sunday), select Weekdays Only.

• If you want to specify weekly updates on a particular day, select Specific 

Day. Then select the desired day.

3. Select the time you want the scheduled updates to start. Many people 
prefer scheduling updates for around midnight when access rates may be 
cheaper and they aren’t using their system.
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4. If you want WebWhacker to whack all URLs that have been enabled, select 
Whack. URLs that have been enabled for whacking include a knife symbol 
( , , or ) in their icon.

5. If you want WebWhacker to look at all subscribed URLs that are eligible 
for renewal (according to their Update Frequency Property) and 
download any that have changed since the last time you whacked or 
renewed them, select Renewal. You can select Whack, Renewal, or both.

6. If you want to modify another preference, select the appropriate tab. If 
you are finished modifying preferences, select OK . 
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Exporting Files

The Export function allows you to save much of the information in your database 
of subscribed URLs to text and image files on your hard drive or local network. 
You can use these files if you want to recycle graphics from a Web page or to 
examine and edit the HTML code of a page you admire. 

How It Works WebWhacker’s Export function works in a manner similar to the File/Save as 
function of your Web browser, except that it adds the ability to automatically save 
all images or other associated files referenced in the HTML code. The exported 
files contain only raw HTML—the information you see when you choose to View 
Document Source in your Web browser. If the HTML page references any images, 
movies, or other enhancements, the associated files are saved in the appropriate 
format (for example, graphics are usually GIFs or JPGs). 

Unless the original Web page creator used relative URLs to reference embedded 
graphics, etc., these exported pages do not include any working links and thus do 
not function like typical Web pages. However, the text file of HTML code, the 
graphic file, or embedded movie file can be viewed with any application that can 
deal with that particular file type. For example, you can view the HTML code with 
most word processors; you can view GIF or JPEG files with most photo-editing 
applications. 

Time Requirement Exporting a large file or group of files may take a long time. As when you are 
deleting or saving a large file to your hard drive, you can not stop the export in the 
middle of the process. 

File Formats When you select a page for export, the Web page files are exported in HTML 
format while the included files retain their native formats (usually GIF or JPG for 
images, AVI or MOV for movies, etc.)

Dating Exported Files Exported files carry the date on which they were saved to disk. They do not 
reference the date on which the original Web page was created or the date on 
which it was last downloaded to your WebWhacker database.
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Exporting Web Pages
and Associated Files Step Procedure

1. To export a particular page and its associated files, select its URL in Tree 
View. If you select a URL that contains images or other multimedia files, 
these associated files are included in the export.

2. From the File menu or Toolbar, choose Export . WebWhacker displays the 
Browse for Folder window.

3. Navigate to the folder to which you want to export the selected file or files. 

4. When you click on Select “Folder Name” (where “Folder Name” is replaced 
by the actual name of the destination folder on your hard drive), the 
selected files are exported as marked.

WebWhacker_Mac.BK : 4_Advanced  Page 18  Friday, September 12, 1997  1:50 PM



Advanced Features

WebWhacker User’s Manual 4–19

Using FTP with WebWhacker

When you use WebWhacker to whack a site that includes FTP (File Transfer 
Protocol) pages, the FTP’d pages cannot be viewed using WebWhacker as a Web 
browser proxy.

Text Files If the pages are text files, you can view these pages if you Export them and then 
view them with a text editor (such as the Simple Text accessory that ships on 
Macintosh computers) or any word processor that can view text files. See 
Exporting Files.

Related Pages:
Exporting Files, pg. 4–17

Compressed Files Other FTP’d files may be compressed files (usually ending in .hqx or .sit). These 
files must be uncompressed using a StuffIt™ utility.
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5

Glossary This reference section contains a glossary of commonly used Internet terms as 
well as special WebWhacker terminology.

Known Problems The Known Problems section describes known problems and product limitations 
as of the date of this manual. For more late-breaking information see the Readme 
file delivered with the product.
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Glossary

add (a URL) Subscribe to a URL by typing its full Internet address. When you add a URL (as 
opposed to grabbing it), you must manually enter the full URL in the URL to Add  
dialog. 

address Either an IP Address (the 32-bit address assigned to TCP/IP host computers) or 
an e-mail address (the name and location address to which all of your electronic 
mail is sent).

Boolean logic Named for 19th century English mathematician George Boole, Boolean logic uses 
AND, OR, and NOT as its primary operators, just as add, subtract, multiply, and 
divide are the primary operators in arithmetic. 

A Boolean search requires that specific conditions must be met. For example, a 
search using the terms tropical and fruits with the AND operator finds all 
occurrences that contained both the word tropical and the word fruits. See 
Searching the Database, pg. 3–24.

bookmark file (also called hotlist and favorites). Collection of Net site addresses saved into an 
HTML file by a Web browser. The list may be organized around a single topic or 
may be a list of the user’s favorite sites.

browser (Web browser) Program that allows the user to find and view information on the World Wide 
Web (WWW). It generally refers to a Web browser, which translates HTML-coded 
pages into graphical interfaces on the user’s computer. See also WWW, pg. 5–9.

category Groups or sets of URLs gathered together. You can define the categories that meet 
your needs. 

database WebWhacker stores indexing and key information about the sites you have saved 
in a database. The files themselves are stored in a special folder. You cannot access 
or manipulate this database with any other database management system; it is in 
a format that only WebWhacker can interpret. However, you can export an 
individual file in raw HTML format. 
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DNS (Domain Name System). Database system used to map the meaningful names 
humans use to refer to machines on the Internet (such as, Blue Squirrel) 
onto the IP addresses that the computers use to access one another. DNS allows 
the user to type in a simple, memorable company name which the computer 
converts into a unique series of numbers. 

domain Technically, the alphanumeric part of the DNS naming system; it is usually 
identifiable as a series of words separated by periods (called dots). For example, 
f f g. com is pronounced ffg-dot-com. In general terms, a domain is a logical 
region of the Internet and is commonly referred to as a site.

e-mail (electronic mail) Method by which computer users can exchange messages over a 
network. E-mail is probably the most widely used communications tool on the 
Internet. There are many conventions to e-mail, but most entail “To:”, “From:”, 
and “Subject:” lines. One of e-mails advantages is its ability to be forwarded and 
replied to easily. 

e-mail address Set of names which routes your e-mail to you. By convention, an e-mail address is 
made up of several parts, separated by periods. The first part of the address, the 
username, identifies a unique user on a server. The “@” (pronounced “at” in the 
United States) separates the username from the host name. The host name 
uniquely identifies the server computer and is the last part of the Internet e-mail 
address. Large servers, such as those used at universities or large companies 
sometimes contain multiple parts, called subdomains. Subdomains and the host 
name are separated by a “.” (pronounced “dot”). 

The three-letter suffix in the host name identifies the kind of organization 
operating the server (some locations use a two-letter geographical suffix). The 
most common suffixes are: com (commercial), edu (educational), gov 
(government), mil (military), net (networking), org (non-commercial). 
Addresses outside of the U.S. sometimes use a two-letter suffix that identifies the 
country in which the server is located. Some examples are: jp (Japan), nl (The 
Netherlands), uk (United Kingdom), ca (Canada), tw (Taiwan).

favorites list See bookmark file, pg. 5–4.
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firewall Network node used as a boundary, or security device, to prevent Internet traffic 
from crossing over from one side to another. A firewall may be implemented in a 
router protecting a company’s or institution’s server, or it may be a specialized 
device used for such purposes.

FTP (File Transfer Protocol) TCP/IP protocol for transferring (copying) from one 
machine on the Internet to another. Basically, it is the Internet version of the File 
Copy functions on most desktop platforms. Since FTP evolved on the UNIX 
platform, its commands for making and changing directories, transferring, 
copying, moving, and deleting files were originally rather arcane text-based 
commands typed at a prompt. Fortunately, many graphical applications are now 
available that make FTP commands as easy as dragging and dropping. 

grab Subscribe to a URL while browsing the site. When you grab a URL (as opposed to 
adding it), the program picks up the URL from your browser for you and 
automatically enters it into the URL to Add text box. See Grabbing a URL, pg. 3–8.

headline Within the context of WebWhacker, title of a whacked URL displayed on a list in 
a special localized Web page. You can click on any of the headlines to load that 
whacked URL into your browser. Headlines generally reflect the title assigned to 
the page by its creator.

home page Point of entry into a company’s, individual’s, or institution’s set of HTML pages 
on the World Wide Web. This foundation page is often used as an index with links 
to other resources on the Web or to other Internet servers.

hotlist See bookmark file, pg. 5–4.

HTML (HyperText Markup Language) Standard way to mark text documents to be 
published on the World Wide Web. HTML code is distinguished by its use of tags 
surrounded by brackets; for example, <BODY> is the standard tag for beginning 
the body of any HTML document. HTML code is what you see when you select 
View Document Source in your browser. 

IP IP stands for Internet Protocol, the second half of the standard TCP/IP package 
that provides the most fundamental protocols on the Internet. IP defines the unit 
of information passed across the Internet.
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IP address 32-bit address assigned to Internet hosts using TCP/IP. 

ISDN (Integrated Services Digital Network) Access provided by telephone carriers 
which combines voice and digital (computer) services on a single medium. ISDN 
connections provide faster access than is available through basic modem 
connections.

knife icons • One knife (for example, ) indicates you only want to whack one level of the 
subscribed URL. 

• Two knives (  or ) indicate you want to whack multiple levels of the 
subscribed URL.

• Red icons (  or ) indicate an error occurred when the URL was whacked.

mirror site Many Web and FTP sites have become so popular that they have acquired “mirror 
sites” to alleviate congestion. Mirror sites are areas on another computer that 
“mirror” or contain an exact replica of the directory structure of the files on the 
overly popular site’s computer. If you have trouble getting connected to an FTP 
site, for example, because of the high amount of traffic, you can usually connect 
to a mirror site that contains the same information on a different computer. 
Mirror sites are usually updated once a day.

PPP (point-to-point protocol) Protocol that provides a method for transmitting 
packets over serial point-to-point links. PPP is one of the most popular methods 
for dial-up connections to the Internet, since it allows you to use other standard 
protocols (such as IPX, TCP/IP, and Netbeui) over a standard telephone 
connection, but it can also be used for LAN connections.

properties Information about any subscribed URL, whether or not it has been whacked yet. 
The URL Properties sheets will give you a URL’s Attributes (Title, URL, Status, 
Creation Time, and Modified Time), Security issues (username and password), 
Update Frequency, any Errors, and Whack Levels with Remain on Site setting. See 
Updating URL Properties, pg. 3–30.

protocol Language spoken between computers to exchange information. More technically, 
a protocol is the formal description of formats and rules followed by machines to 
exchange information. Different protocols are used to exchange different sorts of 
messages, such as news for newsgroups and FTP for file transfers.
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proxy Special kind of application which serves as an interface between the Web browser 
and the actual connection to the Internet. 

proxy server Application which passes information between a browser and the Internet. 

red icons (  or ) Indicates an error occurred while whacking that URL. The problem could be as 
simple as the user cancelling a whack, or it may indicate that a URL or subordinate 
file could not be found. In general, if the red image is a globe, that indicates a 
problem with downloading the URL; if the red image is a smaller globe on a piece 
of paper, that indicates a problem with one of the subordinate files (usually an 
image that could not be found). See Viewing the Error List, pg. 3–29 or Viewing 
Error Properties, pg. 3–37.

remain on site When WebWhacker begins whacking a URL site, it whacks all links to the level you 
specify. If the page has links to another site, you might not want to whack those 
pages. Select Remain on Site in the Whack Levels dialog to keep WebWhacker from 
transversing and whacking links to other sites. You can only use the Remain on Site 
option if you are specifying a number of levels to whack; if you are whacking all 
the links from a page, Remain on Site is selected automatically and the option is 
grayed out, making it unavailable.

SLIP (Serial Line Internet Protocol) Standard protocol (similar to PPP) which is used 
to run TCP/IP over serial lines, such as telephone circuits or RS-232 cables. Unlike 
PPP, however, SLIP does not work on a LAN connections. SLIP is probably the 
most popular way for dial-up users to access the Internet. In general, Web access 
requires a SLIP or PPP connection.

T1/T3 Two terms coined by AT&T to describe the types of high-speed connections of 
hosts to the Internet. A T1connection transmits a DS-1 formatted digital signal at 
1.544 megabits per second. A T3 connection transmits a DS-3 formatted digital 
signal at 44.746 megabits per second.

TCP (Transmission Control Protocol) First half of the standard TCP/IP package that 
provide the most fundamental protocols on the Internet. TCP provides the 
transport level standards that allow a process on one machine to send data to a 
process on another machine.

TCP/IP Standard package that provide the most fundamental protocols on the Internet. 
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URL (Uniform Resource Locator) Standard address format used to identify and locate 
sites on the Internet. World Wide Web site URLs begin with the prefix http:// 
(HyperText Transfer Protocol), generally followed by www (World Wide Web). 
After the standard prefixes, URLs use identifiers for different domains and 
subsections of domains, each separated by a period (.). The various levels of a site 
are separated by a forward slash (/); individual home pages are often preceded by 
a tilde (~).

URL subscription When you add or grab a URL, you create a subscription to that URL. It is called a 
subscription because, like a newspaper or magazine subscription, you can be 
scheduled to automatically receive a copy of the updated materials (in this case, 
the new Web page or pages). See Renewing Subscribed URLs, pg. 3–27.

Web page Page of a document on the World Wide Web.

whack Download a site from its location on the World Wide Web and copy it to your hard 
drive or local network. Depending upon how you have set up the whack (in the 
New URL dialog), your local copy can include all graphics, audio and video clips, 
and links to other pages and/or sites. See Whacking Sites, pg. 3–19 and Setting 
General Preferences, pg. 4–9.

whack levels Number of link levels WebWhacker acquires when it whacks the site. See Updating 
URL Whack Level Properties, pg. 3–39.

WWW (World Wide Web or Web) Collection of on-line documents housed on Internet 
servers around the world. The concept of the Web was created by researchers at 
CERN in Switzerland. Web documents are written or coded in HTML. To access 
these documents, you must use a Web browser, such as Internet Explorer or 
Netscape Navigator. When these browsers access (or hit) a page, the server uses the 
HyperText Transfer Protocol (HTTP) to send the document to your computer.
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Known Problems and Limitations

Browser Links If your system loads a different program when you are expecting it to load your 
Web browser, you may have your browser improperly designated in the 
WebWhacker Preferences. See Setting Browser/Mail Preferences, pg. 4–11.

CGI-Generated Scripts 
and Images

WebWhacker does not support CGI-generated scripts and images. We do, 
however, support client-side image maps.

Database Compression WebWhacker does not currently compress its database when you delete sites; 
however, the program will reuse space recovered from the deleted information 
before using additional hard disk space. A future release will support database 
compression.

Forms (Search Forms) WebWhacker does not support HTML forms (for example, search forms).

FTP When whacking files, be sure that your FTP path ends with a file name. (FTP only 
supports the transfer of files; it does not download directories.)

For example, ftp://somewhere.out.there/files/  does not work. The 
correct format is: ftp://somewhere.out.there/files/file1.txt.

At the present time, WebWhacker does not work as an FTP proxy. See Using FTP 
with WebWhacker, pg. 4–19.

Interrupted Whacks If your modem drops your Internet connection, your operating system may not 
be aware of the lost connection. In that case, WebWhacker may also be unaware 
of the lost connection and may hang. Use the Cancel function (Command-period) 
to stop WebWhacker.

Unsupported Protocols WebWhacker does not support file, gopher, mail, news, and nntp. When the 
program encounters references to these protocols in the HTML, the references are 
skipped.
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New Features in WebWhacker 4.0 for Macintosh  

Name your files as full       With WebWhacker 4.0 you can now save downloaded sites with the full site 
filenames                           filename.  

Example: You can save our web page as: www.bluesquirrel.com

Tree View                        WebWhacker is now easier to navigate thanks to the new Tree View which has  
been added to the 4.0 version.  The Tree View allows a branched view of each 
downloaded site and all of its pages on the hard drive.  To view all of the links 
just double click on the folder you want to view.

One Button Whacking       In our search to make WebWhacker as simple to use as possible we created One 
Button Whacking.  This allows you to just click on the Whack button on the 
tool bar to whack the current page and all of the accompanying graphics.
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